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Purpose
This Manual is intended for assembly of the YoraHome 6550-Pro Laser Engraving 
Machine.

Before beginning assembly, we recommend conducting an inventory using the 
Packing List to ensure all components are present. 

NOTE - there may be extra hardware included; this is normal, in case items get 
dropped or lost.

Please read these instructions carefully before assembling your machine to 
prevent possible damage to your machine.



Safety1/3

➔ Read and understand the entire user manual before attempting assembly or operation
➔ Do not use the laser engraver other than its intended use. If used for other purposes, 

YoraHome disclaims any real or implied warranty and holds itself harmless from any injury 
that may result from that use. 

➔ Always wear approved safety glasses while using the laser engraving machine. Everyday 
eyeglasses will NOT protect your eyes from the laser

➔ It is not recommended to wear loose clothing around moving equipment. Confine long hair. 
➔ Do not operate the laser engraver while tired or under the influence of drugs, alcohol or any 

medication.
➔ Make all machine adjustments or maintenance with laser engraving machine unplugged from 

the power source.
➔ Give your work undivided attention. Looking around, carrying on a conversation and 

“horseplay” are careless acts that can result in serious injury.



Safety2/3

➔ Never leave the laser engraving machine running unattended. Turn the power off and do not 
leave the machine until it comes to a complete stop.

➔ Keep a fire extinguisher nearby since use of the laser may lead to an unexpected fire. 
➔ Remove loose items and unnecessary work pieces from the area before starting laser engraver.
➔ The laser engraver should be set up in a fire-resistant working area with good ventilation.
➔ Keep children away from your laser engraver. Minors of any age should not use this laser without 

direct adult supervision and proper eye protection 
➔ Do not place your hands or any other objects you do not wish to engrave/burn/cut in the path of 

the laser beam. Serious physical harm is possible if used improperly.
➔ Do not touch the heat sink when the laser engraver is in operation, or immediately after use, it 

may cause burns.
➔ Never cut vinyl or PVC. When engraved, a corrosive agent is produced that will destroy the 

machine. Never use unknown materials.



Safety3/3

➔ Make sure the cutting area under the laser is metal or non-flammable. 
➔ Ensure that the room or area you are operating the laser in is sufficiently labeled to prevent 

someone from unknowingly walking into an active work area. 
➔ Never use the laser except for the purpose intended.
➔ When engraving mirror, stainless steel and other reflective materials, please paint the surface 

black to prevent damage to the laser head from reflective light. 
➔ The machine should be placed securely on a flat surface to avoid dropping or being hit.
➔ Be within reach of the Emergency Stop or pause button when the machine is in operation. In 

the event of an emergency, or if there are any conditions that may result in injury to yourself or 
others, the 6550-Pro is equipped with an Emergency Stop button on top of the Controller. 
When pressed, this button will latch in the Stop position. To reset, twist the red knob 
clockwise.
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Packing List1/8Part 1

Name Model Parameter Quantity Picture

Aluminium Profile

Front Frame Rail 1

Rear Frame Rail 1

Left Frame Rail 1

Right Frame Rail 1

X Axis Gantry Rail (with wiring) 1

Bolt

M3x6 22

M3x8 8

M5x8 7

M5x18 6

M5x20 13

M5x25 1



Packing List2/8Part 1
Name Model Parameter Quantity Picture

Timing Belt Y Axis 2

Timing Belt X Axis Brass grommets
pre-installed 1

Timing Belt Clamp 
Screw Y Axis 4

Limit Switch Y Axis 1

Wrench For roller adjustment 8mm/10mm 1

Cable Ties 20

Sanding Disc For removal of burrs, 
as needed 2



Packing List3/8Part 1

Name Model Parameter Quantity Picture

Z Axis Assembly 1

Laser Module
(Diode)

20W package will 
include a wire adaptor

80W/ 96W Electrical 
Power
10W / 20W Optical 
Power

1

X Axis Belt Tensioner 1

Laser Height Gauge With Holder 1

Safety Glasses Style may vary 1

Wire Adaptor
For 20W 
package only



Packing List4/8Part 1

Name Model Parameter Quantity Picture

Frame Feet For left front and rear 3

Frame Foot For right front With flange 1

Feet Anti-Slip Pads 4

Hex Wrench 1.5 | 2 | 2.5 | 3 | 4 1 of each



Packing List5/8Part 1

Name Model Parameter Quantity Picture

Right Motor Assembly For both X and Y axis 2 motors installed 1

Left Motor Assembly For Y axis 1 motor installed 1

X Gantry Assembly
Flame detector 
and limit switch 

installed
1



Packing List6/8Part 1

Name Model Parameter Quantity Picture

Limit Switch Touch 
Plate 1

Drag Chain Bracket - 
X Axis Stepped design 1

Drag Chain Bracket - 
X/Y Axis L-shaped design 1

Drag Chain Support 
Bracket For Y Axis 1



Packing List7/8Part 1

Name Model Parameter Quantity Picture

USB Cable 1

2 Rotary Cables 2

Control Board

Includes wiring, air 
assist tubing, and 

Drag Chain - 
pre-attached

1

Power Supply Includes power cord 1



Packing List8/8Part 1

Name Model Parameter Quantity Picture

Drag Chain Support 
Rail 1

Air Pump

Includes, 8mm(ID) 
outlet Hose and Hose 

Reducer 1

Leg extension kit

Includes 8 Leg 
segments (50mm 

each), 4 Leg pads, 4 
T-slot nuts

1



Optional Accessories (Not Included)Part 1

YoraHome 
Multi-Purpose Rotary

YoraHome
4th Axis Rotary Module

YoraHome
Honeycomb Platform

YoraHome
6550-Pro Expansion Kit

https://yorahome.com/products/tlc-rotary-attachment
https://yorahome.com/collections/laser-engravers-accessories/products/multipurpose-rotary
https://yorahome.com/products/4th-axis-rotary-module
https://yorahome.com/products/4th-axis-rotary-module
https://yorahome.com/products/honeycomb-platform-6550
https://yorahome.com/products/honeycomb-platform-6550
https://yorahome.com/products/6550-pro-expansion-kit
https://yorahome.com/products/6550-pro-expansion-kit


Mechanical InstallationPart 2

Step 11/2

Parts Required: 
➔ 2 M3x6 Screws
➔ 3 M5x8 Screws
➔ Right Motor Assembly
➔ Drag Chain Bracket - X/Y Axis
➔ Drag Chain Support Bracket

Using M3x6 Screws, attach Drag Chain 
Bracket - X/Y Axis to the Right Motor 
Assembly as shown.

Do not use the other 3 screw holes yet!



Mechanical InstallationPart 2
Step 12/2

Using M5x8 Screws, LOOSELY attach Drag 
Chain Support Bracket to the underside of 
the Right Motor Assembly as shown.

Do not tighten these screws until later in 
assembly!
       



Mechanical InstallationPart 2
Step 2
     
Rail Identification -

All Rails will have measurement markings 
along the inside edge of the rail.

On the outside edge of the Left and Right 
Side Rails, check for the clearance bore to 
allow for screw installation, as shown.

Side Rail measurement markings: 0-50 cm

Front/Rear Rail measurements markings: 
0-65cm

  

Measurement 
Markings

Clearance 
Bore



Mechanical InstallationPart 2
Step 3

     Parts Required: 
➔ Right Motor Assembly
➔ Right Side Rail

Slide the Right Motor Assembly 
onto the Right Side Rail as shown 
- note the orientation of the 
measurement markings towards 
the inside of the machine frame.

If the assembly is loose, use the 
supplied wrench and hex key to 
adjust the inner rollers as shown.

  

Roller Adjustment Detail

Measurement 
Markings



Mechanical InstallationPart 2
Step 4

     Parts Required: 
➔ Right Side Rail with Right Motor 

Assembly
➔ Timing Belt
➔ 2 Timing Belt Clamp Screws

Route Timing Belt (with teeth down) 
OVER the synchronous wheel on the Y 
axis stepper motor, and UNDER the 
rollers, as shown.

Secure belt at both ends of the rail as 
shown - do not overtighten and twist 
belt.

Belt should be taut, but still allow free 
movement on the motor assembly.  

Ensure screw hole is 
accessible



Mechanical InstallationPart 2
Step 5

     Parts Required: 
➔ Right Side Rail Assembly
➔ Limit Switch
➔ M5x20 Screw

Install the Limit Switch on the underside 
of the Right Side Rail assembly, as 
shown.

Limit Switch will be positioned at the 
right front corner of the machine frame.

Set Right Side Rail Assembly aside until 
Frame Assembly steps.



Mechanical InstallationPart 2
Step 6

     Parts Required: 
➔ Left Motor Assembly
➔ Left Side Rail

Slide the Left Motor Assembly onto 
the Left Side Rail as shown - note 
the orientation of the measurement 
markings towards the inside of the 
machine frame.

If the assembly is loose, use the 
supplied wrench and hex key to 
adjust the inner rollers as shown.

  

Roller Adjustment Detail

Measurement 
Markings



Mechanical InstallationPart 2
Step 7

     Parts Required: 
➔ Left Side Rail with Left Motor 

Assembly
➔ Timing Belt
➔ 2 Timing Belt Clamp Screws

Route Timing Belt (with teeth down) OVER 
the synchronous wheel on the Y axis 
stepper motor, and UNDER the rollers, as 
shown.

Secure belt at both ends of the rail as 
shown - do not overtighten and twist belt.

Belt should be taut, but still allow free 
movement on the motor assembly.  

Set Left Side Rail Assembly aside until 
Frame Assembly steps.

Ensure screw hole is 
accessible



Mechanical InstallationPart 2
Step 81/2

Parts Required: 
➔ 7 M3x6 Screws
➔ X Gantry Assembly
➔ Z Axis Assembly
➔ Drag Chain Bracket - X Axis

Using 3 of the M3x6 Screws, attach Drag 
Chain Bracket - X Axis to the X Gantry 
Assembly as shown.



Mechanical InstallationPart 2

Step 82/2

Using 4 of the M3x6 
Screws, attach the Z 
Axis Assembly to the 
X Gantry Assembly 
as shown.  



Mechanical InstallationPart 2
Step 9

     Parts Required: 
➔ X Gantry Assembly
➔ X Axis Gantry Rail

Slide the X Gantry Assembly onto the X 
Axis Gantry Rail as shown - note the 
orientation of the wiring to avoid 
pinching wires in the rollers.

NOTE - The 6-pin wire connector end of 
the rail needs to be oriented to the left 
of the machine.

Set X Rail Assembly aside until Frame 
Assembly steps.

6-pin wire connector - 
NOT THE 4-pin wire 

connector!



Mechanical InstallationPart 2
Step 10

     Parts Required: 
➔ Right Side Rail (from Step 5)
➔ Left Side Rail (from Step 7)
➔ Front and Rear Frame Rails
➔ 4 M5x20 Screws

Assemble Frame as shown; using 
M5x20 Screws from the OUTSIDE of 
the Right and Left Side Rails into the 
ENDS of the Front and Rear Frame 
Rails.

Ensure all measurement markings are 
oriented to the INSIDE of the frame.

Do NOT completely tighten these 
screws yet!

LF Corner RF Corner

LR Corner RR Corner



Mechanical InstallationPart 2
Step 11

     Parts Required: 
➔ Frame Assembly
➔ Frame Foot (Right Front)
➔ 3 Frame Feet 
➔ 4 M5x8 Screws
➔ 4 M5x20 Screws

Assemble Frame Feet to Frame 
Assembly as shown; using M5x8 
Screws in the ENDS Right and Left Side 
Rails, and M5x20 Screws into the 
holes located in the Front and Rear 
Frame Rails.

Once these are tight; tighten the 
frame screws from the previous step.

M5x8 M5x20



Mechanical InstallationPart 2
Progress Check -
Your assembly should now look like this - if it does not, verify the previous assembly steps!
       



Mechanical InstallationPart 2
Step 12
     Parts Required: 
➔ Frame Assembly
➔ X Axis Gantry Rail Assembly 

(from Step 9)
➔ 5 M5x18 Screws

With the Z Axis Assembly facing 
the front of the machine, place 
the X Axis Gantry Rail Assembly 
on top of the Right and Left 
Motor Assemblies.

Attach with 3 M5x18 Screws to 
the Right Motor Assembly, and 1 
M5x18 Screw to the Left Motor 
Assembly, as shown.



Mechanical InstallationPart 2
Step 13

CAREFULLY turn the machine upside 
down.

Insert 1 M5x18 Screw from the 
underside of the Left Motor Assembly, 
securing the X Axis Gantry Assembly.

Plug the 6-Pin connector into the 
stepper motor on the Left Motor 
Assembly.

CAREFULLY turn the machine back 
right-side up.



Mechanical InstallationPart 2
Step 14

     Parts Required: 
➔ Limit Switch Touch Plate
➔ 1 M5x25 Screw

Install the Limit Switch Touch 
Plate onto the X Axis Gantry Rail, 
using the center hole on the Left 
Motor Assembly, as shown.

The vertical part of the Limit 
Switch Touch Plate should be 
facing the inside of the frame.



Mechanical InstallationPart 2
Step 15

     Parts Required: 
➔ X Axis Belt Tensioner

The mounting screws for the X Axis 
Belt Tensioner are pre installed.

Loosen the mounting screws 
slightly, and insert the Belt 
Tensioner on the left end of the X 
Axis Gantry Rail. The Belt 
Tensioner will fit against the Limit 
Switch Plate as shown.

Tighten the mounting screws to 
secure the tensioner to the rail.



Mechanical InstallationPart 2
Step 161/2

     Parts Required: 
➔ Timing Belt - X Axis

Starting at the right side of the X 
Axis Gantry - 

Slide one end of the Timing Belt 
into the slot on the X Axis 
Gantry.

Route the Timing Belt to the X 
Axis motor on the Right Motor 
Assembly, and around the 
synchronous wheel of the motor.



Mechanical InstallationPart 2
Step 162/2

     Parts Required: 
➔ Timing Belt - X Axis

Route the Timing Belt along the back of 
the X Axis Gantry Rail, and through the 
Belt Tensioner - the belt must go on the 
inside of the Belt Tensioner housing, as 
shown.

Slide the other end of the Timing Belt 
into the slot on the left side of the X 
Axis Gantry.

Tighten the belt using the knob on the 
end of the Belt Tensioner - allowing 
smooth movement of the X Axis Gantry



Mechanical InstallationPart 2
Step 17

     Parts Required: 
➔ Drag Chain Support Rail
➔ 3 M3x6 Screws

Place the Drag Chain Support Rail on 
the rear side of the X Axis Rail; with the 
flat side of the support rail facing up.

Using 3 M3x6 Screws, attach the Drag 
Chain Support Rail to the Left Motor 
Assembly, as shown.

Do NOT install any screws into the Right 
Motor Assembly at this time.

Flat side UP; ridge facing 
DOWN



Mechanical InstallationPart 2
Step 18

     Parts Required: 
➔ Control Board (with Wiring 

and Drag Chain)
➔ 2 M5x20 Screws

Place the Control Board in the right 
front corner of the machine frame.

Route the wiring behind the right 
front foot, ensuring that the wiring 
is not “pinched” in between the 
Control Board and the foot.

Attach the Control Board to the 
Front Frame Rail with 2 M5x20 
Screws



Mechanical InstallationPart 2
Step 19
 
Route the Drag Chain and wiring 
along the right side of the 
machine.

Ensure the Drag Chain is routed 
OVER the roller on the Drag 
Chain Support Bracket on the 
underside of the Right Side 
Motor Assembly.

At this time, you may tighten the 
screws holding the Drag Chain 
Support Bracket to the Right Side 
Motor Assembly.



Mechanical InstallationPart 2
Step 20

     Parts Required: 
➔ 3 M3x6 Screws

Using 3 M3x6 Screws, attach the 
Y Axis Drag Chain to the right 
front Frame Foot, as shown.

Ensure that no wiring is caught 
under the screws.



Mechanical InstallationPart 2
Step 21

Parts Required: 
➔ 3 M3x6 Screws
➔ 3 M3x8 Screws

Using 3 M3x6 Screws, attach the Y Axis 
Drag Chain to the Right Motor Assembly, 
as shown.

Using 3 M3x8 Screws, attach the X Axis 
Drag Chain to the Right Motor Assembly, 
as shown.

Ensure that no wiring is caught under the 
screws.

M3x8

M3x6



Mechanical InstallationPart 2
Step 22

     Parts Required: 
➔ 3 M3x6 Screws

Using 3 M3x6 Screws, attach the X Axis 
Drag Chain to the X Axis Gantry 
Assembly, as shown.



Mechanical InstallationPart 2
Step 231/6

 
Wire Connections - 

At the Right Motor Assembly, connect the Y Axis 
Motor harness which is underneath the X Axis 
Rail.

Ensure that the wire is routed away from any 
rollers, using cable ties as needed.



Mechanical InstallationPart 2
Step 232/6

 
Wire Connections - 

At the Right Motor Assembly, 
connect the X Axis Motor (upper 
motor) and Y Axis Motor (lower 
motor).

Ensure that the wire is routed 
away from any rollers, using 
cable ties as needed.



Mechanical InstallationPart 2
Step 233/6

 
Wire Connections - 

At the X Axis Gantry, connect the Flame Detector Harness. Ensure that the wire is routed away 
from any rollers, using cable ties as needed.

NOTE: FLAME DETECTION

The 6550-Pro is equipped with a flame detection sensor, 
which will stop the machine in the event of fire detected in 
the engraving area (directly beneath the laser).

In some circumstances, such as direct sunlight, the flame 
detector may trigger in error. If this is preventing machine 
operation, the flame sensor may be unplugged to 
continue.

Important: Unplugging the sensor will remove ALL flame 
detection capability!



Mechanical InstallationPart 2
Step 234/6

 
Wire Connections - 

At the rear of the X Axis Gantry, 
connect the X Axis Limit Switch 
harness.

Ensure that the wire is routed 
away from any rollers, using 
cable ties as needed.



Mechanical InstallationPart 2
Step 235/6

 
Wire Connections - 

At the right front corner,  
connect the Y Axis Limit Switch, 
which is underneath the Y Axis 
Rail.

Ensure that the wire is routed 
away from any rollers, using 
cable ties as needed.



Mechanical InstallationPart 2
Step 236/6

 
Wire Connections - 

In the front right corner of your machine, the stepper motor cable for your rotary can be plugged 
in to the provided 4-pin connector. 

To activate the rotary connection, use the Rotary switch on the back of the controller.

Switching to the rotary to ON will DISABLE both of the Y Axis motors and enable the rotary wire; be 
sure to switch back to OFF for normal operation when not using the rotary.



Mechanical InstallationPart 2
Step 24

     
Parts Required: 
➔ Laser Module Assembly
➔ 4 M3x6 Screws

Using 4 M3x6 Screws, attach the 
Laser Module Assembly to the X 
axis Gantry as shown.

Note: This Process is the same 
for the 10W and 20W packages. 



Mechanical InstallationPart 2
Step 25
Connect the Laser Module wire 
harness to the top of the laser 
module.
For 20W package, plug the laser 
wire harness(A) into the adaptor 
wire, then connect the adaptor 
wire to the laser module.
Connect the Air Assist Tubing to 
the fitting on the bottom left of 
the laser module (10W); this 
connection simply pushes in 
place.
Connect the Air Assist Tubing to 
the fitting on top of the laser 
module (20W); this connection 
simply pushes in place.

Laser Module Connection Air Assist Connection

10W

20W

Connect to 
laser

Connect to 
Laser wire 

A



Mechanical InstallationPart 2
Step 26

     Parts Required: 
➔ Laser Height Gauge Holder
➔ 2 M5x20 Screws

Using 2 M5x20 Screws, attach the 
Laser Height Gauge Holder to the front 
left corner of the frame, as shown.

Note: This process is the same for the 
10W Spacer holder and the 20W 
Spacer holder. 



Mechanical InstallationPart 2
Step 26

     Parts Required: 
➔ Air Pump
➔ 8mm(ID) Tubing & Adapter

Attach the small length of tubing 
with the adapter fitting to the outlet 
of the Air Pump.

Connect the Air Assist tubing from 
the front right corner of the 
machine to the outlet port of the 
Air Pump.

Plug power cord into outlet.



Mechanical InstallationPart 2
Controller Information

The following controls/ports are on the 
controller housing:

Power:  for 24VDC power supply
Connect: USB to computer
Memory Card: not used at this time
Power Switch: turn machine on/off
Estop - Emergency Stop:  latches in safe position
Warning:  indicates flame detection has been 
initiated
Offline Control (future use):  will permit use of 
an offline controller module for machine 
operation.



Mechanical InstallationPart 2
Laser Focus Adjustment

For proper laser operation, the focal height must be set from the work surface.

Using the provided Laser Height Guide, adjust the height of the laser using the Z-Axis thumbscrew; setting 
the distance between the work surface and the bottom of the laser housing. The magnetic shield must be 
removed to set the height.

Do NOT set the height to the air assist outlet nozzle or the shield; this will result in poor engraving quality!



Mechanical InstallationPart 2
Laser Focus Adjustment

For proper laser operation, the focal 
height must be set from the work 
surface.

Using the provided Laser Height Guide, 
adjust the height of the laser using the 
Z-Axis thumbscrew; setting the distance 
between the work surface and the 
bottom of the laser housing. The 
magnetic shield must be removed to set 
the height.

Do NOT set the height to the air assist 
outlet nozzle or the shield for the 10W 
laser; this will result in poor engraving 
quality!



Mechanical InstallationPart 2
Feet Adjustment (To Lift the machine or To Use Your Rotary Module)

Parts Required: 
➔ 8 Leg segments (50mm each)
➔ 4 T-slot nuts
➔ 4 Leg pads

Using the T-slot nuts, attach one leg 
segment (50mm) to each corner of the 
frame to raise the machine. 

You can insert the second leg segment for 
additional height (100mm total). 

Attach the pads to the bottom of the legs 
for greater stability.



Software IntroductionPart 3

Install the machine’s driver (CH340SER). Download it online here.
NOTE FOR MAC USERS: If your Mac is running Mojave OS or higher, do NOT install the 
driver, as the OS has native support for the CH340. If you are running Sierra or High 
Sierra, please contact YoraHome Technical Support for additional guidance.

1.

https://cdn.shopify.com/s/files/1/2640/0786/files/CH34x_Install.zip?3163


Software IntroductionPart 3

• Windows XP: Right click on My Computer, select Manage, then Device Manager.
• Windows 7: Click on Start on the taskbar, right click on Computer, select Manage, then Device Manager.
• Windows 10: In the search box on the taskbar, type Device Manager, then select it from the menu.

In the tree, expand Ports (COM & LPT). 
Your machine will be identified by the 
USB Serial Port (COMX), where the “X” 
represents the COM number, for 
example COM3.

If there are multiple USB serial ports, 
right click on each one and check the 
manufacturer, the machine’s should be 
"CH340".

2

1

3

        Determine your machine COM’s port2.

Note - Machine must be connected 
to your computer in order for a COM 
port to be assigned.



Software IntroductionPart 3

LaserGRBL is one of the best Windows GCode streamers for DIY Laser 
Engravers. LaserGRBL is able to load and stream GCode path to your control 
board, as well engrave images, pictures and logos with internal conversion 
tool. 

The software is free and it is available on the CD or the USB disk that comes 
with your machine. You can also go to  the LaserGrbl official website to 
download the latest version. You will also find on the website many tutorials 
showing  show how to use this powerful software.

If you own a Mac computer, we recommend LightBurn (premium software 
with a free trial available) which is a laser engraving software that delivers 
great results too.

In the next pages, we will provide a quick introduction on how to use 
LaserGRBL; followed by a quick introduction to the basics of Lightburn.

Only For Windows Users

For Windows & Mac Users

        Install Your Laser Engraving Software3.

https://lasergrbl.com/
https://github.com/arkypita/LaserGRBL/releases/download/v3.0.24/install.exe
https://lightburnsoftware.com/


Software Introduction - LaserGRBLPart 3

1. 2.Open the LaserGRBL 
Software

Select the desired COM 
port, then click the 
“Connect” icon



Software Introduction - LaserGRBLPart 3

3. 4.If the connection is 
successful, you will see the 
message below in the 
Console window

Test your machine for proper motion control 
using the “Jog” buttons - if the Y axis is 
reversed, switch the motor cable to the other 
white port on the control board.

The highlighted “slider” indicates the distance 
the machine will move when a “Jog” button is 
clicked; in millimeters



Software Introduction - LaserGRBLPart 3

6. To load an image for engraving, click on the “File” menu, then select “Open 
File”. In the Windows Explorer window; navigate to the desired image file on 
your computer. Common file types are JPG, BMP, PNG, SVG.



Software Introduction - LaserGRBLPart 3

You can use the default 
settings or adjust them - 
see our tutorial videos 
in YoraHome Facebook 
CNC Users Group or My 
YoraHome Knowledge 
Base for additional 
information.

7. Parameters default, click next

https://www.facebook.com/groups/YoraHome.CNC
https://www.facebook.com/groups/YoraHome.CNC
https://my.yorahome.com/
https://my.yorahome.com/
https://my.yorahome.com/


Software Introduction - LaserGRBLPart 3

The engraving speed and MIN/MAX settings will need to be adjusted to meet 
the material being engraved.

Note that the size values will automatically update whenever one is changed 
in order to maintain the aspect ratio of the origin image.

Then click the “Create” button

8.



Software Introduction - LaserGRBLPart 3

Using the jog buttons, position the laser to the lower left corner of the desired 
burn location; then click the “Globe” button to set the origin.
Then click the “Play” button to start the laser engraving process. 

9.



Software Introduction - LightburnPart 3

1. 2.Open the Lightburn 
Software

In the lower right of the screen, in the “Laser” pane, 
click on “Devices”



Software Introduction - LightburnPart 3

3. 4.In the Devices dialog box, 
click on the “Create 
Manually” button.

The “New Device Wizard” will start - select 
the “GRBL” option, and click “Next”



Software Introduction - LightburnPart 3

5. 6.The default connection 
method should be 
“Serial/USB” - click “Next”.

If you would like to name the machine, you 
may do so here. Set the work area dimensions 
as shown - X=650; Y=500 - click “Next”.



Software Introduction - LightburnPart 3

7. 8.Set the origin for your laser - on the 
6550, that is the Front Left. If you wish 
to use the Auto-homing function, set 
that toggle to “True” - click “Next”.

Confirm your settings, then click “Finish” 
to return to the Devices screen.



Software Introduction - LightburnPart 3

9. Click on “OK” to return to the 
main Lightburn screen.



Software Introduction - LightburnPart 3

10. Click on the “File” menu, then select “Import” to open an image 
file.In the Windows Explorer window; navigate to the desired image 
file on your computer. Common file types are JPG, BMP, PNG, SVG.



Software Introduction - LightburnPart 3

11. To set the engraving parameters, select the image on the grid, then go to 
the “Cuts/Layers” tab in the upper right pane (see next page for detail).



Software Introduction - LightburnPart 3

12. Select your imported image, then select the parameters for your engraving - in 
the example below, we have selected a engraving speed of 1000 mm/min, at a 
power of 60%; with the mode set to “Fill”. This will direct the machine to burn 
the entire image and fill in the shape.



Software Introduction - LightburnPart 3

13. Select the “Move” tab, and use the jog buttons to position your 
laser at the lower left corner of where the design is to be burned. 
Click on the “Set Origin” button to set the start position.



Software Introduction - LightburnPart 3

14. Use the Power setting and the “Fire” button to turn the laser 
on at low power for focusing, click again to turn the laser off. 

If the “Fire” button is not 
visible, go to the Device 
Settings on the “Edit” menu, 
and select the “Enable Laser 
Fire Button” option. Lightburn 
must be restarted to activate 
this option.



Software Introduction - LightburnPart 3

15. Finally, click on the “Start” button in the Laser pane to start the 
laser engraving process.



FAQPart 4
Q. Where do I find GRBL settings or configuration?
A. In LaserGRBL software, select GRBL -» GRBL Configuration, then make a screenshot to save all the current and original settings 
of your board before making any changes.

Q. What do I check if my laser does not power up?
A. In LaserGRBL software, go to GRBL configuration. Find the $32 value and make sure it is equal to 1. If it is equal to 0, change it 
to 1, click on the Write button on the bottom of the window to store this information on the board, and reboot your machine.

Q. How tight should my timing belts be on the 6550-Pro?
A. Timing belts should be tight enough to not slip, but not so tight as to make smooth movement an operation’s issue. 

Q. What speed and max power do I need to use?
A. This is not a firm value we can provide for every situation; please check our blog page for recommended settings for some 
materials: https://yorahome.com/blogs/news/laser-engraving-settings

Q. What if we have missing or broken parts?
A. Please notify: support@yorahome.com

Q. Where can I find additional resources for the YoraHome 6550-Pro?
A. In our Blog https://yorahome.com/blogs/news, Knowledge Base https://my.yorahome.com/, Facebook group 
https://facebook.com/groups/YoraHome.CNC, and Forum https://community.yorahome.com/.
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